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Introduction 
 
The present user manual is designed for the Landis+Gyr MAP120 Para-
meter Editor Version 6.2 and higher.  
 
This user manual contains all information required for the use of the 
Landis+Gyr MAP120 Parameter Editor. It not only provides explanations 
concerning functionality and general procedures, but also gives detailed, 
illustrated instructions on how to use the software. 
 
The contents of this user manual are intended for technically qualified per-
sonnel of energy supply companies responsible for system planning, para-
meter setting and installation of devices. 
 
The Landis+Gyr MAP120 Parameter Editor runs on personal computers 
with the Windows operating system. To understand this user manual, you 
need basic knowledge of Windows and its terms, as well as a general idea 
of how to operate a personal computer. Furthermore, you need to be famil-
iar with the functional principles of the various devices supported by the 
Landis+Gyr MAP120 Parameter Editor, which are described in the corre-
sponding user manuals and functional specifications. 
 
The following conventions are used in this manual: 

1. 2. 3.  Ordinal numbers are used for individual steps in the instruc-
tions.  

View Buttons, menu names and individual menu items appear in 
bold text. 

[F1] Keys are shown in square brackets. 

[Ctrl]+[S] Key combinations are shown with a plus sign (e.g. [Ctrl] key 
kept pressed while pressing [S] key) 

"Open" Names of windows, directories and elements appear in quota-
tion marks.  

 

Scope 

Purpose 

Target group 

Conditions 

Conventions 
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1 Overview 
The Landis+Gyr MAP120 Parameter Editor supports services needed to 
edit and download complete device definitions (parameterisations) into 
Landis+Gyr devices (meters, communication modules and communication 
units).  

The following diagram illustrates the various fields of application of the 
Landis+Gyr MAP Tools. 

 

1.1 Functions 

The Landis+Gyr MAP120 Parameter Editor supports the following func-
tions:  

 Create and edit device definitions 

 Read complete device definition from a device 

 Wizard to write complete device definition to a device and execute 
related actions (e.g. clock setting, register reset) 

 Write data blocks to a device (e.g. TOU, security system) 

 Save and open complete device definition files 

 Compare two device definitions 

 Print a device definition 
 

1.2 Communication channels 

The Landis+Gyr MAP120 Parameter Editor can communicate with the 
devices via the following communication channels: 

 Local: Optical head, RS232, RS4585, CS, M-Bus  

 Modem: PSTN, GSM  

 Network: GPRS, Ethernet  
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1.3 Communication protocols 

The Landis+Gyr MAP120 Parameter Editor supports the following com-
munication protocols:  

 dlms / HDLC 

 dlms / COSEM Wrapper over TCP 

 IEC 62056-21 (formerly known as IEC 1107) 
 

1.4 Editions 

The Landis+Gyr MAP120 Parameter Editor is solely as "Professional 
Edition" available. 

The edition is determined by the licence data (see section 3 "Licensing").  
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2 Installation and uninstallation 
This section describes the installation of the Landis+Gyr MAP120 Para-
meter Editor on the hard disk of your PC and its uninstallation if it is no 
longer used.  

2.1 Installation 

 
To be able to run the Landis+Gyr MAP120 Parameter Editor, your PC must 
be equipped with the operating system Windows 10, Windows 8, Windows 
7 or Windows Vista.  
 
Administrator privileges on your computer are required for the installation 
and the licensing.  
 
The installation software for the Landis+Gyr MAP120 Parameter Editor can 
be downloaded to your PC via the Internet from the Landis+Gyr homepage 
www.landisgyr.eu. Please contact your sales representative to receive the 
required username and password for the download. 
 
The required language must be selected at installation time. It can be 
changed again at any time in the Landis+Gyr MAP120 Parameter Editor. 
 
Please read the file "MAP120_ReadMe.txt" with current information about 
the present version of the Landis+Gyr MAP120 Parameter Editor. 
 
Start the installation file "Setup.exe" and then follow the instructions of the 
setup wizard. 
 
Close the Landis+Gyr MAP120 Parameter Editor, if it is in use. Then Start 
the installation file "Setup.exe" and follow the instructions of the setup wiz-
ard. 

All data including the license and the communication profiles is kept when 
upgrading the Landis+Gyr MAP120 Parameter Editor with version 2.3 or 
later (older versions than 2.3 cannot be upgraded). 

When upgrading a former version 6.2 to the latest version 6.2 the former 
version will be automatically replaced by the newer one.  

When upgrading a former version 2.3, 2.4, 2.5, 3.x, 4.x, 5.0 to 5.4, 5.7 or 
5.8 to the latest version 6.2, the new version can also be installed in parallel 
to a former version. In this case a separate directory is required for the in-
stallation.  

Former releases prior to 2.3 can't be upgraded.  

To restore the communication profiles of versions older than 4.0 copy the 
content of the "\profiles" subdirectory from the former to the new version. 
Since version 4.0 the communication profiles are located in the following 
directory: 

 Users\%username%\AppData\Roaming\Landis+Gyr\MAP120. 
 
With the configuration settings you can also define any other directory for 
the communication profiles to allow the sharing of communication profiles 
with different users of a PC.  
 

System requirements 

Administrator 
privileges 

Installation software 

Language 

Preparation 

First installation 

Upgrades 

http://www.landisgyr.eu/product/map/
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2.2 Uninstallation 

If the Landis+Gyr MAP120 Parameter Editor is no longer needed, it should 
be uninstalled.  

To do so, open the Windows Control Panel and use "Uninstall a program" 
from the "Programs" category. 
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3 Licensing 
This section explains the licensing concept and describes the steps neces-
sary for licensing the Landis+Gyr MAP120 Parameter Editor.  

3.1 Introduction to the licensing concept 

After installation, the Landis+Gyr MAP120 Parameter Editor is licensed as 
Demo version, i.e. it can only be used with reduced range of functions. For 
unrestricted use of the Landis+Gyr MAP120 Parameter Editor it must be 
licensed as Professional Edition. For this, Landis+Gyr provides you with the 
following license data, to be entered in the Landis+Gyr MAP120 Parameter 
Editor: 

 User Name 

 User Group (Version) 

 License Key 
 
The procedure is described in section 3.2 "Entering license data".  

The license is valid for an unlimited time. The same license data can be 
used for several MAP120 installations.  

3.2 Entering license data 

This section describes the licensing procedure required for unrestricted use 
of the Landis+Gyr MAP120 Parameter Editor. The license data received 
from Landis+Gyr following your order is required for this purpose.  

Procedure: 

1. Click on Start and then under All programs in the Landis+Gyr 
program group from the menu Landis+Gyr MAP120 - 6.2 select the 
Landis+Gyr MAP120 - 6.2 command.  
The Landis+Gyr MAP120 Parameter Editor is started and the "MAP120 
- Communication Center" window appears. 

2. Click on Cancel to close the "MAP120 - Communication Center" 
window. 

3. Select License from the Extras menu.  
The "License" window appears.  

 

4. Enter the user name provided by Landis+Gyr in the "User" entry box.  

5. Select the user group provided by Landis+Gyr in the "User Group" 
selection field.  

6. Enter the licence key provided by Landis+Gyr in the "License Key" 
entry box. To prevent from illegal copying placeholders are shown 
instead of the license key after input. 
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7. Click on OK. 
The licensing procedure is terminated.  

The Landis+Gyr MAP120 Parameter Editor is now ready for use 
according to the instructions given in section 4 "First steps" or 8 
"Application of MAP120 functions", respectively.  
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4 First steps 
This section gives an introductory example of how a communication con-
nection is established to a device with the Landis+Gyr MAP120 Parameter 
Editor.  
 

Device

serial connection 
(USB or COM port)

Personal computer

with MAP120

 

A device ready for operation and an optical reading head for connection to 
a serial interface (USB or COM port) are required for this purpose. The 
Landis+Gyr MAP120 Parameter Editor must also be installed on the PC 
and licensed.  

Procedure: 

1. Connect the cable of the optical reading head fitted on the device to 
the serial interface of the PC. 

2. Click on Start and then under All programs in the Landis+Gyr 
program group from the menu Landis+Gyr MAP120 - 6.2 select the 
Landis+Gyr MAP120 - 6.2 command.  
The Landis+Gyr MAP120 Parameter Editor is started and the following 
message appears, if no communication profiles are yet defined:  

 

3. Confirm this message with OK. 
The "MAP120 - Communication Center" window appears. All commu-
nication settings must be made here as shown below. More detailed 
information can be found in section 6.1 "MAP120 communication 
center".  

4. In the selection box "Document Type" select the document type "Para-
meterisation Tree (Base Meter, Module AD-xG/xP)".  

5. In the selection box "Interface" select the serial interface to which the 
optical reading head is connected.  

6. In the selection box "Interface Type" select "Optical Head".  

7. In the selection box "Transmission Rate" select "300".  

8. In the selection box "Access Level" select "[1] Data Collection".  
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9. Click on Advanced.  
The "MAP120 - Advanced Protocol" window appears. 

 

10. Click on the tab "Access Levels" and enter a valid password for access 
level "[1] Data Collection".  

 

Setting up a commu-
nication profile 
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11. Click on OK.  
The password is saved and the "MAP120 - Advanced Communication 
Settings" window disappears.  

12. Click on New.  
The "MAP120 - New Profile" window appears. 

 

 

13. Enter a name for the new profile or leave the proposed name.  
The proposed name is made up from the main settings of the profile.  

14. Click on OK.  
The new profile is saved and appears afterwards in the selection box 
"Communication Profile Selection".  

 

Entering passwords 

Saving the commu-
nication profile 
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15. Click on Connect.  
The communication is started and the data is loaded from the con-
nected device. During this operation, which can last up to several 
minutes depending on the number of objects to read, a progress bar 
is displayed.  

 

 

After termination of the readout the loaded data is displayed as para-
meterisation tree in the Landis+Gyr MAP120 Parameter Editor.  

 

16. Select Exit from the File menu. 
After an inquiry, whether the parameterisation tree shall be saved or 
not, the application is terminated and all resources are released.  

This concludes the introductory example. Further instructions with more 
detailed explanations are provided in the following sections. 

Establishing commu-
nication connection 
and reading data 
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5 Description of user interface 
This section describes the user interface of the Landis+Gyr MAP120 
Parameter Editor.  

5.1 Overview 

The user interface of the Landis+Gyr MAP120 Parameter Editor comprises 
the following areas:  

 Menu bar with the "File", "View", "Communication", "Extras", "Window" 
and "Help" menus to call up functions 

 Tool bar with buttons for direct call-up of functions frequently used 

 Device definition window with tree representation (left-hand part) and 
details representation (right-hand part) 

 Trace window (normally not activated)  

 Status bar 
 

 

The sizes of the areas for the tree representation window, details repre-
sentation window and trace window can be set individually with the mov-
able separating bars situated in between (click separating bar and move 
with mouse button pressed). 
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5.2 Menu bar 

The menu bar of the Landis+Gyr MAP120 Parameter Editor contains the 
following menus for selecting functions: 

 File menu for file handling functions (new, open, close, save, export, 
print etc.). 

 View menu for display and search functions. 

 Communication menu for communication setting and transmit func-
tions. 

 Extras menu to call up functions for licensing, option setting and tree 
comparisons.  

 Window menu for window arrangement functions. 

 Help menu to call up online help and read-me files, version indication 
and update checks.  

5.3 Tool bar 

 

The tool bar of the Landis+Gyr MAP120 Parameter Editor contains the 
following buttons for direct call-up of functions frequently required: 

 
creates a new device definition and opens the "MAP120 - Communi-
cation Center" window 

 
opens a stored device definition file 

 
saves the selected device definition file 

 
prints the selected device definition 

 
calls up a print preview of the selected device definition 

 
selects the next higher folder in the tree  

 
sends the selected parameters to the device 

 
loads the selected parameters from the device (service tree only) 

 
disconnects the MAP120 connection from the device  

 
enables/disables the trace window 

 
calls up the MAP120 version indication 

 

Buttons which are not applicable in a specific situation are disabled and 
represented in grey.  
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5.4 Device definition window 

Device definition windows show a parameter representation of a device 
type (in this user manual only the parameterisation tree is described, since 
the service tree is only supported for some older firmware versions of spe-
cific devices).  

Normally the device definition window is represented maximised, i.e. it uses 
the entire space in the MAP120 Parameter Editor.  

Clicking the  button in the upper right corner of the MAP120 downsizes 
the device definition window, so that more than one device definition win-
dow can be displayed at once. Using the entries "Cascade" or "Tile" from 
the "Window" menu allows automatic arrangements of windows.  

 
 
1  Left-hand half of window with tree representation of device definition 

2  Movable separating bar 

3  Right-hand half of window with detailed view of selected tree items 

 
Device definition windows are divided into two by a movable separating bar 
(moved by clicking and shifting the bar). The left-hand half of the window 
contains a general tree representation, while on the right are displayed de-
tails of the current tree item marked (parameter or folder).  

The active window half can be changed by pressing [F6] or by clicking in 
the other window half. This does not change the focus and marking in the 
newly activated window half. In the basic condition the first tree item is se-
lected in the left-hand half and the first element for modification or the first 
button in the right-hand half. Both sectors of the window have horizontal 
and/or vertical picture scrolling functions if part of the window half cannot 
be seen. Scrolling does not affect either the focus or the current marking.  

Clicking the  button in the upper right corner of a downsized device 
definition window maximises the device definition window again.  
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A tree representation, e.g. as generally familiar from the file system tree of 
Windows Explorer, is ideally suited for clear presentation of ordered struc-
tures (e.g. of files placed in folders and sub-folders) and is therefore used 
for the representation of device definitions.  

 

 
A tree consists of a hierarchic arrangement of tree items (folders and 
parameters).  

The tree items are represented as follows:  

 Root folder 

 Folder 

 Parameter 

 Modified parameter (with asterisk) 

  Read-only parameter 

Various statuses of parameters are indicated with different colours of tree 
items.  
 
Each folder can be expanded and collapsed individually. If the tree is fully 
collapsed, only the root folder remains visible, which represents the entire 
device (all parameters).  

Collapsed folder items are preceded by an expansion sign , expanded 
folder items by a collapse sign .  

To expand or collapse folders there are the following possibilities:  

Using the mouse: 

 Clicking on the expansion sign  of a folder expands this folder  
(the expansion sign changes to a collapse sign ).  

 Clicking on the collapse sign  of a folder collapses this folder  
(the collapse sign changes to an expansion sign ).  

Tree representation 

Tree items 

Folder handling 
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Using the keyboard: 

 Pressing the [*] key of the numerical keyboard expands the whole tree 
below the selected folder (i.e. all subfolders and parameters will be 
visible).  

 Pressing the [/] key of the numerical keyboard collapses the whole 
tree below the selected folder (i.e. all subfolders and parameters will no 
longer be visible).  

 Pressing the [+] or [–] key of the numerical keyboard toggles between 
the expanded and collapsed tree representation.  

5.5 Trace window 

 

 Additional knowledge required 
Additional knowledge is required to analyse communication activities.  

 

Clicking on  in the tool bar shows or hides the trace window, where all 
communication activities can be logged and analysed.  

 

The trace level can be adjusted for each category (DLMS, Wrapper, HDLC 
and IEC) individually: off, low, medium and high.  

To analyse a specific string, mark it in the trace window, click on the button 
for the corresponding analysing window, e.g. Analyse HDLC Frame and 
then click on Analyze in the analysing window.  
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5.6 Status bar 

 

The following information is displayed in the status bar: 

 General status (e.g. Ready) or tooltip of a selected icon in the tool bar  

 Connection status (e.g. Modem) and protocol (e.g. dlms) 

 Type of tree (e.g. Parameterisation Tree) 

 Connection icon (e.g. ) 

 Keyboard status (e.g. NUM for activated numerical keypad) 
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6 Communication with devices 
This section describes all aspects of communication with devices, in par-
ticular work with the MAP120 communication center for various applica-
tions.  

6.1 MAP120 communication center 

All communication settings can be made in the "MAP120 Communication 
Center" window. This mainly serves to select the desired document type 
and suitable communication profile, as well as to establish or terminate a 
connection to the device.  

The "MAP120 - Communication Center" window appears 

 following every start of the MAP120 (except when this has been sup-
pressed in the option settings)  

 after creating a new document (click on  or select New from the 
File menu)  

 when called up (select Communication Center from the Communi-
cation menu). 

 

For a better understanding of the possible settings in the MAP120 commu-
nication center some important terms and communication parameters are 
explained below, before the completion of various communication connec-
tions is shown by means of examples in section 6.2 "Communication exam-
ples".  
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6.1.1 Document types 

The document type (tree type) must be selected in the MAP120 communi-
cation center for every communication connection to a device. The follow-
ing document types are available (depending on license):  

 Parameterisation Tree (Base Meter, Module AD-xG/xP) 

 Parameterisation Tree (Communication Unit) 

 Service Tree (Base Meter)* 

* Only supported for some older firmware versions of specific devices (see 
readme.txt file) and therefore not documented in this user manual. It is rec-
ommended to use the MAP110 Service Tool for service functions. 

The parameterisation tree and its application is described in detail in 
section 7 "Parameterisation tree".  

6.1.2 Communication profiles 

Communication profiles stored in the MAP120 contain all necessary 
settings for a specific type of connection to a device:  

 Connection specification (interface used, type of interface, transmis-
sion rate for direct connections or modem type and telephone number 
for modem connections, start protocol, COM port settings etc.).  

 Access specification (access levels, passwords) 

 Physical device address 

 Network delay times 

A communication profile must be determined or selected in the MAP120 
communication center for every communication connection to a device. 
With the choice of a stored communication profile all settings no longer 
have to be made separately each time. Any desired number of communi-
cation profiles can be specified and stored.  

The communication profiles are stored in files commonly for all users in the 
directory "C:\Documents and Settings\All Users\Application Data\Landis+ 
Gyr\MAP120\Profiles". Changes in a communication profile therefore affect 
all users of a personal computer. 
 
The following basic procedure should be adopted to produce and store a 
new communication profile in the MAP120 communication center (specific 
examples are given in section 6.2 "Communication examples"): 

1. Select the serial interface to be used in the "Interface" selection box or 
the modem used for remote communication and for Ethernet connec-
tions the entry of the network card to be used. The COM port number 
of a serial interface can be found in Windows under Settings / Control 
panel / System / Hardware / Device manager. 

2. For local communication select the "Optical Head" type used in the 
"Interface Type" selection box or "3-wire connection without echo" or 
for remote communication the telephone number to be selected.  

3. Select the corresponding transmission rate for the device for local com-
munication in the "Transmission Rate" selection box.  

4. Select the access level required for the intended activity in the "Access 
Level" selection box.  

5. If extended communication settings are necessary, click on Advanced.  
The "MAP120 - Advanced Communication Settings" window appears. 

Preparation example 
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6. Perform the required extended communication settings and then click 
on OK. 
The "MAP120 - Advanced Communication Settings" window disap-
pears. 

7. Click on New.  
The "MAP120 - New Profile" window appears. 

 

8. Enter a name for the new communication profile or leave the name 
suggested. 
The name suggested is formed from the most important settings of the 
communication profile. 

9. Click on OK.  
The new communication profile is stored and then appears as entry in 
the "Communication Profile Selection" box. 

 

 

 Temporary use of communication profile settings 
If it is only intended to use communication profile settings temporarily, they 
need not to be saved as communication profile. Instead, they can be used 
by clicking on Apply.  

 



Communication with devices     25/96 

D000011154 en t – MAP120 – Parameter Editor – User Manual © Landis+Gyr 

6.1.3 Interface to device 

The communication connection from the Landis+Gyr MAP120 Parameter 
Editor to one or more devices can be made in various ways:  

 Local via a serial connection to a device. 

- With an optical reading head placed at the optical interface of the 
device (only point-to-point connection to a device possible).  

- With a direct connection to a device, e.g. via an RS232, M-Bus or 
Ethernet interface as used in various communication units. If the 
communication unit has a second interface, multiple connections 
are possible to further devices.  

 With a modem connection to a device or several devices, if these are 
connected together by a multiple connection by RS485, CS or M-bus. 
Note: the modem must first have been installed and configured on the 
PC.  

 With a network connection over the Internet via a gateway (e.g. a 
Landis+Gyr iMEGA server) to a device or several devices, if these are 
connected together by a multiple connection by RS485, CS or M-bus. 
Note: For network connections over the Internet via a gateway a virtual 
COM port and a corresponding standard modem driver must have 
been installed.  

The connection to a PC with the MAP120 software is made either via a se-
rial interface (e.g. COM port or USB) or via a modem or network connected.  
 
The interface used must be selected in the MAP120 communication center 
in the "Interface" selection box. The selection contains all the serial inter-
faces present on the PC and all modems configured, e.g.:  

 
 
If a modem is selected, an entry box "Phone" appears for the telephone 
number:  

 
 
If a serial interface is selected, the "Interface Type" and "Transmission 
Rate" entry boxes appear. The transmission rate to be entered in the 
"Transmission Rate" box must correspond to the device settings.  

Interface 

Phone 

Interface Type and 
Transmission Rate 
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"3-wire connection without echo", "Optical Head" or "Bluetooth Optical 
Head" should be selected as interface type, depending how the device is 
connected.  

 

This is necessary because an echo signal is often produced when using an 
optical reading head, which can be suppressed by suitable means in the 
MAP120, while this effect does not occur with a direct connection.  

If one of these two effects should not take place at any time (a correspond-
ing error message is given in this case when connection is made), it can be 
corrected by clicking on Advanced and suitably changing the characteris-
tics of the physical interface or start protocol in the "MAP120 - Advanced 
Communication Settings" window appearing.  
 
Possible settings in the "Start Protocol" selection box: 

 IEC (default), if the IEC protocol must be used mandatory 

 HDLC, if the HDLC protocol must be used mandatory 

 COSEM Wrapper, if the COSEM Wrapper over the TCP protocol must 
be used mandatory 

 

 

Start Protocol 

Advanced 
Communication 
Settings 
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Possible settings in the "Echo Handling of Interface" selection box:  

 automatically, according to interface type (default), i.e. with echo, if 
an optical reading head is used or without echo, if a direct connection 
is used 

 with echo (e.g. optical head), if a direct connection is used, which 
causes an echo 

 without echo (e.g. electrical interface), if an optical reader is used, 
which causes no echo. 

Possible settings in the "COM Port Settings" selection box:  

 8 Bit (8 data bits / no parity) (default), to be used normally 

 9 Bit (8 data bits / even parity), to be used if the connection to the se-
rial interface of the personal computer is made via an USB M-Bus con-
verter 

Additional setting possibilities on the "Advanced Communication Settings" 
register card: 

 Maximum Transmission Rate (Default = 9600)  
This can be selected in the selection box for the IEC protocol. If HDLC 
is selected as start protocol, no selection is possible.  

 Ignore Transmission Rate Switching   
If this check box is activated with IEC protocol selected, the starting 
transmission rate selected is permanently retained. This is necessary, 
for example, for communication with devices, which must be contacted 
via a multiple connection with a lower transmission rate than required 
by the modem circuit.  

 HDLC transmit buffer size (Default = 128 Bytes)  
This can be entered in the entry box. The permissible range is 62 ... 248 
Bytes. Landis+Gyr recommend to reduce the HDLC transmit buffer 
size only in case of communication problems.  

 Maximum Number of Attributes per dlms Request (Default = 45) 
In case of readout problems this value can be reduced down to 1. 
It should be noted that this slows down the readout.  

 Single Request Firmware Releases  
This entry box contains all versions (separated by semicolons), for 
which automatically single requests will be used.  

 Network Delays (Default = 4000 ms)  
The initial delay and timeout time for problems in making connection, 
e.g. with GSM networks, can be set in the "Initial Delay" and "IEC and 
HDLC Timeout" entry boxes. Note that the "Network Delays" check 
box in the "MAP120 - Communication Center" window must also be 
activated for this setting to be effective (otherwise the IEC standard 
values remain effective).  
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6.1.4 Access levels 

An access level must be selected for every communication connection to a 
device in the MAP120 communication center.  

 

The various access levels and their fields of application are fully described 
in section 10 "Short description of device security system".  

Any passwords necessary can be changed in the "MAP120 - Advanced 
Communication Settings" window, which appears after clicking on Ad-
vanced (see section 6.1.5 "Passwords"). 
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6.1.5 Passwords 

Any passwords necessary can be changed on the tab "Access Levels" in 
the "MAP120 - Advanced Communication Settings" window, which appears 
after clicking Advanced in the "MAP120 - Communication Center" window 
(see section 6.1.4 "Access levels").  

 

 

 Changing default passwords 
Landis+Gyr recommends that the generally known default passwords in the 
device should be changed.  

 
For the user-defined access level X the client type (UID) can also be deter-
mined. This is extremely useful for temporary use of another access level 
or for access to devices from other manufacturers using different client 
types.  
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6.1.6 Addressing devices 

For point-to-point connections the device need not be specially addressed. 
But with multi-drop all devices connected to the bus system (RS485, CS or 
M-Bus) must have their own address for individual access. This address is 
called the physical device address. In fact even two physical device ad-
dresses are used, one for the IEC protocol (IEC device address) and the 
other for the DLMS protocol (HDLC device address).  

Unless otherwise specified on the order, the following parameter values are 
set as defaults for these physical device addresses: 

 Physical IEC device address = serial number (printed on face plate of 
device), e.g. 73852799. 

 Physical HDLC device address = last 4 digits of serial number plus 
1000 (because with dlms the range of addresses is limited and some 
addresses are reserved), e.g. 3799 for a serial number 73852799 
(2799 + 1000 = 3799). 

The physical device addresses are stored as parameters of the basic meter 
and not in the communication unit. A change of communication unit does 
not therefore affect the addressing.  

In the parameterisation tree the physical device addresses can found under 
"Identification Numbers".  
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6.2 Communication examples 

This section provides some examples to show how communication connec-
tions are made to devices via various communication paths and for various 
applications:  

 Local connection (see section 6.2.1) 

 Modem connection (see section 6.2.2) 

 Network connection (see sections 6.2.3) 

It is assumed in all examples that the physical connections (e.g. cable 
or modem connections) have already been made and the Landis+Gyr 
MAP120 Parameter Editor has already been started.  

6.2.1 Local connection 

This example shows how a multiple connection is made to several devices 
mutually connected via RS485 interfaces. dlms is used as communication 
protocol. In the layout diagram below the device numbers are given for ad-
dressing.  
 

Device
76048477

RS232

Personal computer
with MAP120

Device
75005282

Device
73706202

Device
74651799

RS485 RS485 RS485

CU
B2

CU
B1

CU
B2

CU
B2

 

Procedure: 

1. Click on  in the toolbar or select New from the File menu.  
The "MAP120 - Communication Center" window appears showing the 
settings last used. 

2. Select the desired document type in the selection box "Document 
Type" e.g. "Parameterisation Tree (Base Meter, Module AD-xG/xP)". 

3. Select or create a communication profile with the following settings 
(procedure see section 6.1.2 "Communication profiles"): 

- Selection box "Interface": serial interface, to which the connection 
cable to the RS232 interface of the first device (in this example no. 
76048477) is connected, e.g. COM1.  

- Selection box "Interface Type": 3-wire connection without echo.  

- Selection box "Transmission Rate": Transmission rate according to 
the parameter setting of the device, e.g. 57600.  

- Selection box "Start Protocol": HDLC, since access is to take place 
via the dlms protocol. 

- Selection box "Access Level": required access level for the planned 
action, e.g. "[2] Utility Field Service". 



32/96      Communication with devices 

© Landis+Gyr D000011154 en t – MAP120 – Parameter Editor – User Manual 

4. Activate the "Physical Address" check box and enter the physical de-
vice addresses in the entry/selection box for the device to be contacted 
or select them, if they have been entered already. Enter first the IEC 
device address and then separated by a semicolon the HDLC device 
address. The IEC device address corresponds to the device serial 
number and the HDLC device address is calculated from the last 4 
digits of the serial number plus 1000, e.g. 2799 for the device with the 
serial number 74651799 (see also section 6.1.6 "Addressing devices"). 

 

5. Click on Connect.  
The communication is started and the data is loaded from the con-
nected device. After termination of the readout the loaded data is dis-
played as parameterisation tree in the Landis+Gyr MAP120 Parameter 
Editor (see section 7 "Parameterisation tree"). Then the connection is 
disconnected automatically.  

6. Perform the intended work. 

7. If it is desired to communicate with another device in the multiple con-
nection, select Communication Center from the Communication 
menu.  
The "MAP120 - Communication Center" window appears. 

8. In the entry/selection box "Physical Address" enter the physical device 
addresses of another device of the multiple connection or select them, 
if they have been entered already. In this example "73706202;7202" for 
the device 73706202. 
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9. Click on Connect.  
The communication is started again and the data is loaded from the 
connected device. After termination of the readout the loaded data is 
displayed as parameterisation tree in the Landis+Gyr MAP120 Para-
meter Editor. Then the connection is disconnected automatically.  

10. Also perform the required work for this device. 

6.2.2 Modem connection 

This example shows how a point-to-point connection is made for remote 
communication with a single device fitted with a communication unit with 
PSTN modem (CU-M2x) or with GSM modem (CU-G3x). dlms is used as 
communication protocol.  
 

RS232

Personal computer
with MAP120

Device

PSTN modem

Modem connection 33600 bps

CU
M2x

 

If further devices are connected to the device (multiple connection), their 
addressing has to be done with the physical device addresses as shown in 
the example in section 6.2.1 "Local connection". 

Procedure: 

1. Click on  in the toolbar or select New from the File menu.  
The "MAP120 - Communication Center" window appears showing the 
settings last used. 
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2. Select the desired document type in the selection box "Document 
Type" e.g. "Parameterisation Tree (Base Meter, Module AD-xG/xP)". 

3. Select or create a communication profile with the following settings 
(procedure see section 6.1.2 "Communication profiles"): 

- Selection box "Interface": any available PSTN modem.  

- Entry/selection box "Phone": telephone number of the remote 
modem.  

- Selection box "Start Protocol": HDLC, since access is to take place 
via the dlms protocol. 

- Selection box "Access Level": required access level for the planned 
action, e.g. "[6] Remote Data Collection". 

- If the modem in the device is a GSM modem, check box "Network 
Delays" should be activated. 
This increases the time delays with respect to the standard value of 
1500 ms to the value set under "Advanced Communication Set-
tings" (default value = 4000 ms). Increasing the time delays pre-
vents the occurrence of interruptions during data transmission and 
is urgently recommended for GSM networks. 

 

4. Click on Advanced.  
The "MAP120 - Advanced Communication Settings" window appears. 

5. Click on the tab "Access Levels" and enter the valid password for 
access level "[6] Remote Data Collection".  
For test installations at Landis+Gyr "66666666" is programmed as 
password for access level 6.  
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6. Click on OK.  
The "MAP120 - Advanced Communication Settings" window disap-
pears. 

7. Click on Connect.  
The communication is started and the data is loaded from the con-
nected device. After termination of the readout the loaded data is dis-
played as parameterisation tree in the Landis+Gyr MAP120 Parameter 
Editor.  

 

8. Perform the intended work. 

9. Click on  in the toolbar or select Disconnect from Device from the 
Communication menu to conclude the modem connection.  
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6.2.3 Network connection via a LAN 

This example shows how a point-to-point connection is made via a LAN to 
a single device equipped with a communication unit CU-E2x. 
 

Ethernet

Personal computer
with MAP120

Device

Switch or Router

Ethernet

CU
E2x

 

If further devices are connected to the device (multiple connection), their 
addressing has to be done with the physical device addresses as shown in 
the example in section 6.2.1 "Local connection". 

Procedure: 

1. Click on  in the toolbar or select New from the File menu.  
The "MAP120 - Communication Center" window appears showing the 
settings last used. 

2. Select the desired document type in the selection box "Document 
Type" e.g. "Parameterisation Tree (Base Meter, Module AD-xG/xP)". 

3. Select or create a communication profile with the following settings 
(procedure see section 6.1.2 "Communication profiles"): 

- Selection box "Interface": any available network card.  

- Entry box "IP Address": IP address and IP port number para-
meterised in the communication unit, separated by a colon, e.g. 
"192.168.1.31:5000".  

- Check box "Network Delays" activated. 
This setting occurs automatically if a network card is selected as 
interface. This increases the time delays with respect to the stan-
dard value of 1500 ms to the value set under "Advanced Communi-
cation Settings". Increasing the time delays prevents the occurrence 
of interruptions during data transmission.  

- Selection box "Start Protocol": HDLC. 

- Selection box "Access Level": required access level for the planned 
action, e.g. "[2] Utility Field Service". 
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4. Click on Advanced.  
The "MAP120 - Advanced Communication Settings" window appears. 

5. Enter an "Initial Delay" of 100 ms and an "IEC and HDLC Timeout" of 
10000 ms.  
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6. Click on OK.  
The "MAP120 - Advanced Communication Settings" window disap-
pears. 

7. Click on Connect.  
The communication is started and the data is loaded from the con-
nected device. After termination of the readout the loaded data is dis-
played as parameterisation tree in the Landis+Gyr MAP120 Parameter 
Editor (see section 7 "Parameterisation tree"). Then the connection is 
disconnected automatically.  

8. Perform the intended work. 

6.3 Reference to other documents 

Detailed information about Landis+Gyr Dialog communication solutions can 
be found in the following documents. 

 Data sheets for the various communication units  

 User manuals for the various communication units  

 Functional description of communication units  

 Detailed application notes for numerous reference applications with 
various communication units for different transmission media  

All these documents as well as advisory services are available from the 
competent representative of Landis+Gyr. 
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7 Parameterisation tree 
This section describes the parameterisation tree used for the representa-
tion of device definitions.  

7.1 Overview 

The parameterisation tree displays all parameters of a device, but no 
device register values. When called up, the parameters are read out 
automatically from the device into the parameterisation tree.  

The parameterisation tree permits re-parameterisation of devices (except 
configuration) and comparison of parameters in the device and in the tree. 
From the parameterisation tree complete device definitions or selected data 
blocks (e.g. TOU, security system) can be downloaded into the device, but 
no individual parameters.  

The following example shows a part of a device parameterisation tree: 

 

The individual parameters are described in the functional description for the 
relevant device. 
 
Data selection is made in the parameterisation tree with the aid of the 
parameterisation wizard described in section 7.2 "Parameterisation wizard".  
 
MAP device document files (*.prd) with parameterisation data exported 
from MAP190 can be opened in MAP120 as parameterisation tree (see 
section 8.1.2 "Opening existing device definitions").  

 

Selecting data 

Importing 
MAP190 files 
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Some functions applicable with parameterisation trees are described in the 
following sections:  

 Section 7.3.1 "Switching the certification feature on or off" 

 Section 7.3.2 "Comparing parameterisation tree to file" 

 Section 7.3.3 "Comparing parameterisation tree to device" 

 Section 7.3.4 "Exporting TOU table" 

 Section 7.3.5 "Update firmware version" 

7.2 Parameterisation wizard 

The parameterisation wizard controls the data selection for parameterisa-
tions, i.e. it permits the selection of individual parameter groups and their 
loading in the device connected:  

 All parameters except the security system (for meters and communi-
cation units) 

 General security system or parts thereof, e.g. passwords (for meters 
and communication units) 

 Complete TOU or parts thereof, e.g. individual switching tables (only 
for meters) 

The parameterisation wizard permits the input of individual parameter val-
ues, such as identification numbers or passwords, for convenient para-
meterisation of several devices with the same parameterisation tree. The 
values entered are read to the device instead of the corresponding values 
from the parameterisation tree.  

For the parameterisation of meters with all parameters except the security 
system the parameterisation wizard also allows actions to be performed 
before or after parameterisation, e.g. time setting or resetting registers and 
profiles.  

The starting of the parameterisation wizard and its various parameterisation 
possibilities are described in the sub-sections below. 

7.2.1 Starting the parameterisation wizard 

The precondition for calling up the parameterisation wizard is that a para-
meterisation tree is displayed in the MAP120, either read out from a device 
or opened as file.  

Procedure: 

1. Click on  in the toolbar or select Send to Device from the Commu-
nication menu.  
The "MAP120 - Communication Center" window appears showing the 
settings last used.  

2. Select or create a communication profile with the necessary access 
level for the planned re-parameterisation.  
Note that an impermissible access level is only recognised and dis-
played when writing the parameter to the device connected. 

Functions 
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3. Click on Connect.  
The communication is started and the data is loaded from the con-
nected device (they are neither displayed nor saved, however, in the 
parameterisation tree).  

The parameterisation wizard then appears with the current information 
on the parameterisation tree and the device connected (device firm-
ware and configuration). The device number is also displayed. 

Example of base meter parameterisation tree: 
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The possible selection of parameters depends on compliance between 
the device firmware and the configuration: 

- Change all parameters except security system 
can only be selected if the device firmware and the configuration of 
tree and device correspond. 

- Change TOU only 
can only be selected if both the tree and the device have a time 
switch according to the configuration and both belong to the same 
device family. 

- Change Security System 
can only be selected if the device firmware of tree and device corre-
spond.  

Example of communication unit (CU) parameterisation tree:  

 

The possible selection of parameters depends on compliance between 
the device firmware and the configuration: 

- Change all parameters except security system 
can only be selected if the device firmware and the configuration of 
tree and communication unit correspond.  

- Change Security System 
can only be selected if the device firmware of tree and communica-
tion unit correspond.  

 

7.2.2 Change all device parameters except security system 

Procedure: 

1. Start the parameterisation wizard.  

2. Leave the option "Change all parameters except security system" 
selected in the "Parameter Selection" area.  
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3. Click on Next >.  
The identification numbers, device addresses and clock data are dis-
played. 
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4. Mark the identification numbers and device addresses, which are to be 
re-parameterised, and enter the desired values in the input boxes of 
the "Tree" column.  
Note that these inputs are only used for the re-parameterisation and 
are not accepted in the parameterisation tree. Only the identification 
numbers and device addresses marked are written in the device (also 
blank boxes, by which values can be deleted in the device).  

 

5. Select one of the clock setting actions specified before parameteri-
sation:  

- Set clock to PC time 

- Set clock to PC time plus offset 
The time shift can be selected in the selection box in a range of  
± 12 hours (e.g. if the device is used in another time zone). 

- Do not change clock 

6. Click on OK.  
All parameters except the security system are written in the device 
(identification numbers and device addresses from the input boxes 
marked in the parameterisation wizard, remaining parameters from the 
parameterisation tree).  
A new start of the device is then performed, if necessary, and the com-
munication connection opened. The "MAP120 - Actions after parame-
terisation" window appears.  
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7. Mark all or individual profiles or registers, which are to be deleted in the 
device. The possible choice depends on the current configuration 
of the device. 

8. Click on OK.  
The communication connection is established and all profiles and 
registers marked are deleted.  
The communication connection is then disconnected again.  
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7.2.3 Change TOU 

Procedure: 

1. Start the parameterisation wizard.  

2. Select the option "Change TOU only" in the "Parameter Selection" 
area.  

 

3. Click on Next >.  
The "MAP120 - TOU" window appears.  

4. Mark the time switch parts to be copied in the device.  

 

5. Click on Finish.  
All time switch parts selected are written to the device from the para-
meterisation tree.  
The communication connection is then disconnected.  
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7.2.4 Change device security system 

Procedure: 

1. Start the parameterisation wizard.  

2. Select the option "Change Security System" in the "Parameter 
Selection" area.  

 

3. Click on Next >.  
The "MAP120 - Security System" window appears.  

4. Mark the access rights and passwords to be written in the device and 
enter the passwords in the input boxes. Note that these inputs are only 
used for re-parameterisation and are not accepted in the parameteri-
sation tree. Only the passwords marked are written in the device.  
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5. Click on Finish.  
The access rights (if selected) and all passwords selected are written 
in the device.  
The communication connection is then disconnected.  
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7.2.5 Change all CU parameters except security system 

Procedure: 

1. Start the parameterisation wizard.  

2. Leave the option "Change all parameters except security system" 
selected in the "Parameter Selection" area.  

 

3. Click on Next >.  
The parameter groups are displayed. 

4. Mark the parameter groups to be re-parameterised.  

 

5. Click on Finish.  
All parameters selected are written in the communication unit.  
The communication connection is then disconnected.  
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7.2.6 Change CU security system 

Procedure: 

1. Start the parameterisation wizard.  

2. Select the option "Change Security System" in the "Parameter Selec-
tion" area.  

 

3. Click on Next >.  
The "MAP120 - Passwords" window appears. 

4. Mark the passwords to be written in the communication unit and enter 
these in the input boxes.  
Only the passwords marked are written in the communication unit. 

 

5. Click on Finish.  
The passwords selected are written in the communication unit.  
The communication connection is then disconnected.  



Parameterisation tree     51/96 

D000011154 en t – MAP120 – Parameter Editor – User Manual © Landis+Gyr 

7.2.7 Change CU modem initialisation strings 

Procedure: 

1. Start the parameterisation wizard.  

2. Select the option "Change Modem Initialisation Strings" in the "Para-
meter Selection" area.  

 

3. Click on Next >.  
The "MAP120 - Parameterisation" window with modem initialisation 
strings appears. 

4. Enter or modify the AT commands and answers in the input boxes.  

 

5. Click on Finish.  
The modem initialisation strings are written in the communication unit.  
The communication connection is then disconnected.  
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7.3 Parameterisation tree functions 

7.3.1 Switching the certification feature on or off 

With the changeover function "Certification Feature" the tree representation 
can be changed over and returned from normal to certification feature rep-
resentation. This function is only relevant for Germany.  

Procedure: 

1. Select Certification Feature from the View menu.  
A tick in front of the menu item indicates that the certification feature 
representation is currently switched on. After clicking on the menu item 
the tick in front of it disappears and the normal tree representation is 
shown.  

 

2. Select Certification Feature again from the View menu if you want to 
show the certification feature representation (toggle function).  
No tick in front of the menu item indicates that the certification feature 
representation is currently switched off. After clicking on the menu item 
the tick in front of it reappears and the certification feature representa-
tion is displayed.  
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7.3.2 Comparing parameterisation tree to file 

For parameter comparison with a file (only available for parameterisation 
trees, but not for all types of device) the active device definition is com-
pared with a selected file. Differences detected are marked. 

Procedure: 

1. Activate the device definition, which you want to compare to a stored 
device definition.  

 

2. Select Compare to File from the Extras menu.  
The "Open" window appears (this is an operating system dialog win-
dow and therefore the dialog language depends on the version of your 
Windows user interface).  

3. Select your personal data folder in the displayed tree structure if it is 
not already displayed.  

4. In the selection box "Files of type" select either "MAP Parameterisation 
Document" or "MAP Device Document". 

 

5. Double-click on the desired file name or mark it and then click on 
Open.  
Comparison of the two device definitions is performed and the result 
displayed in a compare tree. This only contains the different tree items.  
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6. Expand the folder structure to display the differences. 
The tree items for the active device definition are shown in blue and 
those for the file in red. The details are shown in the right-hand half of 
the window.  

 

 

7.3.3 Comparing parameterisation tree to device 

For parameter comparison with a device (only available for parameterisa-
tion trees, but not for all types of device) the active device definition is com-
pared with a connected device. Differences detected are marked.  

Procedure: 

1. Activate the device definition, which you want to compare to the con-
nected device.  

 

2. Select Compare to Meter from the Extras menu.  
The "MAP120 - Communication Center" window appears.  
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3. Click on Connect. 
If the activated device definition is connected to the device, this con-
nection must first be broken. Communication is started and the com-
parison performed. A progress bar is displayed during this process. 
When the comparison is completed, the result is displayed in a com-
pare tree. This only contains the different tree items.  

4. Expand the folder structure to display the differences. 
The tree items for the active device definition are shown in blue and 
those for the connected device in red. The details are shown in the 
right-hand half of the window.  

 

 

7.3.4 Exporting TOU table 

With the "Export TOU table" function the switching table can be exported 
from parameterisation trees to a file (DAT file for IEC based tools or XML 
file for dlms based tools). These data can be used for download with a suit-
able tool, e.g. a hand-held terminal. Please contact your Landis+Gyr agent 
for further details.  
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Procedure: 

1. Activate the window with the parameterisation tree from which the 
switching table is to be exported.  

2. Select Export TOU to file (IEC W4) or Export TOU to file (dlms) from 
the File menu.  
A "Dialog" window appears if Export TOU to file (dlms) was selected. 
Otherwise the "Save as" window appears directly (continue with point 4). 

 

3. Enter a name and select an expiration date for the TOU to be exported, 
then click on OK. 
The "Save as" window appears (this is an operating system dialog win-
dow and therefore the dialog language depends on the version of your 
Windows user interface).  

 

4. Select the desired folder in the displayed tree structure if it is not 
already displayed.  

5. Enter the desired designation for the switching table in the "File name" 
entry box.  
The name of the device connected is suggested. This suggestion can 
be overwritten. 

6. Click on Save. 
The switching table is saved. A corresponding message is displayed. 

 

7. Click on Ok to confirm the message.  
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7.3.5 Update firmware version 

With the function "Update Firmware Version" parameterisation trees of a 
specific software version can be converted to the next highest software 
version. This function can only be selected if a higher firmware version is 
available.  

Procedure: 

1. Activate the window with the parameterisation tree, for which the firm-
ware version is to be adapted.  

2. Select Update Firmware version from the File menu.  
The "MAP120 - Update Firmware Version" window appears.  

3. In the selection field "New Firmware Version" select the required new 
version to which the parameterisation tree is to be converted.  

 

4. Click on OK. 
The parameterisation tree will be converted to the new firmware ver-
sion. Then the "Save as" window appears (this is an operating system 
dialog window and therefore the dialog language depends on the ver-
sion of your Windows user interface).  

5. Select the desired folder in the displayed tree structure if it is not 
already displayed.  
A list of all stored device definition files will be shown.  

 

6. Enter the desired name for the device definition in the entry box "File 
name".  
The proposed name corresponds to the connected device with the new 
firmware version. You can overwrite this proposal.  

7. Click on Save. 
The device definition will be saved. The device definition name in the 
title bar changes according to the selected name.  
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8 Application of MAP120 functions 
This section contains instructions for the use of functions of the Landis+ 
Gyr MAP120 Parameter Editor, which have not already been explained in 
preceding sections. The sequence corresponds to the menu structure of 
the application. The table of contents should be used to find the required 
function. 

8.1 File handling functions 

File handing functions can be called up in the File menu. 

8.1.1 Creating new device definitions 

The function "New" generates a new blank tree structure, in which the 
definition of the device connected can then be loaded.  

Procedure: 

1. Click on  in the toolbar or select New from the File menu.  
The "MAP120 - Communication Center" window appears showing the 
last used settings. 

 

2. Select the desired document type in the corresponding selection box, 
e.g. "Parameterisation Tree (Base Meter, Module AD-xG/xP)".  

3. Select the desired communication profile in the corresponding selec-
tion box.  
If no suitable communication profile is found in the selection box, you 
can also create a new one according to section 6.1.2 "Communication 
profiles"). 

4. Click on Connect.  
The communication is started and the data is loaded from the con-
nected device. During this operation, which can last up to several 
minutes (depending on the number of objects in your device), a pro-
gress bar is displayed.  
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After termination of the readout the loaded device definition is dis-
played in the new device definition window. The designation in the title 
bar of the window depends on the device connected.  

 

Now you can work with the loaded tree, i.e. reading parameters from 
the device, modifying them and writing them back to the device.  
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8.1.2 Opening existing device definitions 

The "Open" function allows stored device definitions to be opened. The 
selected device definition will be represented in a device definition window.  

Procedure: 

1. Click on  in the toolbar or select Open from the File menu.  
The "Open" window appears (this is an operating system dialog win-
dow and therefore the dialog language depends on the version of your 
Windows user interface).  

 

2. Select your personal data folder in the displayed tree structure if it is 
not already displayed.  

3. Select the desired document type in the selection box "File of type". 
The display is then reduced to the selected document type. Default 
setting is "All Files (*.*)". The following further document types can be 
available (depending on the license):  
- MAP Parameterisation Document (*.ddr) = File with param. tree 
- MAP Service Document (*.dds) = File with service tree 
- MAP Device Document (*.prd) = MAP190 File with param. tree 
- MAP Compare Document (*.ddc) = File with compare tree 
- MAP Logical Device Data (*.ldd)  

4. Double-click on the desired entry in the list or select it and then click on 
Open.  
The selected device definition will be loaded and viewed.  
It is also possible to select a recently opened device definition from the 
MRU (most recently used) list in the File menu. This list contains as 
maximum the last 6 opened file names. Clicking on a list entry opens 
the corresponding device definition directly.  
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The device definition just opened becomes the active window.  

 

8.1.3 Closing device definition windows 

The "Close" function closes the active device definition window.  

Procedure: 

1. Activate the device definition window to be closed.  

2. Select Close from the File menu.  
The active window will be closed. If the device definition was modified 
but not yet saved, the "Save as" window appears and allows you to 
save it.  

8.1.4 Saving device definitions 

The "Save" function saves the device definition in the active window under 
the original name. If the device definition was newly created or is to be 
saved under a new name, you have to proceed as described in section 
8.1.5 "Saving device definitions under a new name".  

Procedure: 

1. Activate the window with the device definition to be saved.  

2. Click on  in the toolbar or select Save from the File menu.  
If the device definition was modified since it was last saved (recognis-
able by the asterisk in the title bar) the modified data will overwrite the 
previously stored data without any warning.  
If the device definition was not modified (no asterisk in the title bar) it 
will not be saved again.  
If a new device definition has not yet been saved, it must be saved 
using the "Save As" function described in the next section.  



62/96      Application of MAP120 functions 

© Landis+Gyr D000011154 en t – MAP120 – Parameter Editor – User Manual 

8.1.5 Saving device definitions under a new name 

The "Save As" function saves the device definition in the active window 
under a new name.  

Procedure: 

1. Activate the window with the device definition to be saved under a new 
name.  

2. Select Save As from the File menu.  
The "Save as" window appears (this is an operating system dialog win-
dow and therefore the dialog language depends on the version of your 
Windows user interface).  

3. Select the desired data folder in the displayed tree structure if it is not 
already displayed. 
A list of all stored device definition files of the same type will be shown.  

 

4. Enter the desired name for the device definition in the entry box "File 
name".  
If the device definition was newly created, the proposed name corre-
sponds to the connected device. Otherwise the name formerly used is 
proposed. You can overwrite this proposal.  

5. Click on Save. 
The device definition will be saved. The device definition name in the 
title bar changes according to the selected name. 
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8.1.6 Printing device definitions 

The "Print" function prints out the device definition in the predefined form 
(see section 8.1.7 "Defining the print layout").  
 

 Selecting printer before printout 
Printing problems are often caused by a change of printer selected. It is 
therefore recommended to select the printer already before printing ac-
cording to section 8.1.9 "Setting up the printer". 

 

Procedure: 

1. Activate the device definition window you want to print.  

2. Expand or collapse the folders as they should appear on the printout. 
To do so click on the corresponding expansion signs  in the tree.  
If you want to see all items of the tree you can expand the whole tree 
at once by pressing the "*" key of the numerical keyboard.  
If you always want to print the tree fully expanded activate the corre-
sponding check box in the "Page Setup" window (see section 8.1.7 
"Defining the print layout"). 

 

3. Select Print from the File menu.  
The "Print" window appears (this is an operating system dialog window 
and therefore the dialog language depends on the version of your 
Windows user interface).  

Clicking on  in the toolbar would start printing immediately without 
displaying the "Print" window.  

4. Make the necessary settings (number of pages and copies).  
It is recommended not to change the type of printer at this stage to 
avoid printing problems. Preferably select the type of printer before-
hand as described in section 8.1.9 "Setting up the printer".  
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5. Click on OK. 
The device definition is printed out on the selected printer as defined 
by default.  
If desired, the print layout can be changed individually (see section 
8.1.7 "Defining the print layout").  
A preview prior to printing can also be performed (see section 8.1.8 
"Previewing the printout on the screen").  



Application of MAP120 functions     65/96 

D000011154 en t – MAP120 – Parameter Editor – User Manual © Landis+Gyr 

8.1.7 Defining the print layout 

The "Page Setup" function allows you to determine the desired page layout 
for printouts of a device definition.  

Procedure: 

1. Select Page Setup from the File menu.  
The "MAP120 - Page Setup" window appears.  

 

2. If you want to printout the fully expanded tree, mark the corresponding 
check box.  
Otherwise the tree will be printed in the current expansion state.  

3. Click on the "Layout" tab. 
A dialog for the layout characteristics is displayed. The margins, the 
header and footer heights and the body indents cannot be changed.  

 

4. Click on Font if you want to set the font according to your wishes. 
The default font is Arial Standard with 10 Pt. 

5. Click on the "Header" tab. 
A dialog for the header determination is displayed.  
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6. Enter the desired header text.  
You may define a left-justified, centered and right-justified header text. 
The following special text marks will be substituted with actual values 
where available (or otherwise left blank): 
- Ampersand character (&&) 
- File name (&F) 
- Page number (&P) 
- Total number of pages (&N) 
- Date (&D) 
- Date last saved (&S) 
- Time (&T) 
- Device type (&Y) 
- Device manufacturer (&M) 

7. In addition or instead of a keyed-in text or special text marks (&) you 
may insert predetermined formats, selectable in the selection box 
"Formats", at any position into the text. 
The corresponding special text mark (e.g. &P) is inserted into the entry 
box as a placeholder after the arrow button beneath the entry box has 
been clicked on. 

 

8. Click on the "Footer" tab. 
A dialog for the footer determination is displayed.  

9. Define the footer in the same way as the header. 
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10. Click on OK. 
This terminates the page setup for printing. You can now perform a 
print preview on the screen (see section 8.1.8 "Previewing the printout 
on the screen") or start the printout directly (see section 8.1.6 "Printing 
device definitions").  

8.1.8 Previewing the printout on the screen 

The "Print Preview" function allows you to check the result of the page 
setup by previewing the printout on the screen prior to printing.  

Procedure: 

1. Activate the device definition window you want to preview on the 
screen.  

2. Expand or collapse the folders as they should appear on the screen. 
To do so click on the corresponding expansion signs  in the tree.  
If you want to see all items of the tree you can expand the whole tree 
at once by pressing the "*" key of the numerical keyboard (afterwards 
you have to scroll up the tree pane to see the root of the tree again).  
If you always want to print the tree fully expanded activate the corre-
sponding check box in the "MAP120 - Page Setup" window (see 
section 8.1.7 "Defining the print layout").  

3. Select Print Preview from the File menu.  
The "Print Preview" window appears.  

 

4. Adjust the "Print Preview" window to a suitable size.  
The size of the displayed page is adapted automatically. 
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The seven buttons offer you the following possibilities, if enabled: 

Print terminates the preview mode and starts the printout.  

Next Page advances the print preview to show the next page (or next 
two pages if in two page mode). The button is disabled if the print pre-
view already shows the last page. 

Prev Page changes the print preview to show the previous page (or 
previous two pages if in two page mode). The button is disabled if the 
print preview already shows the first page. 

Two Page / One Page toggles the display to show one or two full 
pages at once (it is a toggle button that changes its name from Two 
Page to One Page and vice versa if pressed). This button is only en-
abled if the preview does not show a magnified preview.  

Zoom In selects the next higher magnification (three magnifications 
are selectable).  

Zoom Out selects the next lower magnification (three magnifications 
are selectable).  

Close terminates the preview mode.  

5. Click on Zoom In until the size of the print preview representation is 
sufficient for a check of the details.  
The same effect is achieved by positioning the cursor over the preview 
document (its shape changes to a magnifying glass) and pressing the 
left mouse button. 
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6. If the result does not correspond to your wishes close the print preview 
and perform the necessary changes in the print setup (see section 
8.1.7 "Defining the print layout" and section 8.1.9 "Setting up the 
printer").  

7. Click on Close.  
The "Print Preview" window disappears. 

8.1.9 Setting up the printer 

The "Print Setup" function is a standard Windows function, which allows 
you to make the necessary printer settings prior to printing.  

Procedure: 

1. Select Print Setup from the File menu.  
The "Print Setup" window appears (the dialog language depends on 
the version of your Windows user interface).  

 

2. Make the necessary settings (printer selection, printer properties, 
paper size, source and orientation). 

3. Click on OK. 
The new printer settings are stored and will be used for the next 
printouts.  
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8.1.10 Terminating the program 

The "Exit" function terminates the Landis+Gyr MAP120 application.  

Procedure: 

1. Close any open device definition windows. 

2. Select Exit from the File menu. 
The application is terminated, the communication is closed and all 
resources are released.  

If you try to terminate the application, while any device definition win-
dow with modified and not yet saved data is still open, a security dialog 
appears, giving you the opportunity to save the corresponding data:  
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8.2 View functions 

View functions can be called up in the View menu.  

8.2.1 Expanding and collapsing tree folders 

The various functions for expanding and collapsing the tree structure are 
explained in section 5.4 "Device definition window". Only the functions for 
selection in the menu are mentioned here.  

Procedure: 

1. Select Expand All from the View menu to expand the whole tree 
below the selected folder (i.e. all subfolders and parameters will be 
visible).  

2. Select Collapse All from the View menu to collapse the whole tree be-
low the selected folder (i.e. all subfolders and parameters will no longer 
be visible).  

8.2.2 Switching the toolbar on and off 

The "Toolbar" toggle function enables you to hide or show the toolbar in the 
main window of the application.  

Procedure: 

1. Select Toolbar from the View menu.  
A tick in front of the menu item indicates that the toolbar is currently 
switched on. After clicking on the menu item the tick in front of it dis-
appears and the toolbar is no longer visible.  

 

2. Select Toolbar again from the View menu, if you want to show the 
toolbar (toggle function).  
No tick in front of the menu item indicates that the toolbar is currently 
invisible. After clicking on the menu item the tick in front of it reappears 
and the toolbar is displayed again.  
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8.2.3 Switching the status bar on and off 

The "Status Bar" toggle function enables you to hide or show the status bar 
in the main window of the application.  

Procedure: 

1. Select Status Bar from the View menu.  
A tick in front of the menu item indicates that the status bar is currently 
switched on. After clicking on the menu item the tick in front of it disap-
pears and the status bar is no longer visible.  

 

2. Select Status Bar again from the View menu, if you want to show the 
status bar (toggle function).  
No tick in front of the menu item indicates that the status bar is cur-
rently invisible. After clicking on the menu item the tick in front of it 
reappears and the status bar is displayed again.  
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8.2.4 Searching items 

With the "Find" function you can perform a full text search in the whole tree.  

Procedure: 

1. Activate the device definition window in which you want to search an 
item. 

2. Select Find from the View menu.  
The "MAP120 - Full Text Search" window appears. [Ctrl]+[F] has the 
same effect.  

3. Enter the expression you want to find.  
Note that the search is not case sensitive. 

 

4. Click on Find!.  
The item with the searched expression is highlighted (the folder con-
taining the item is automatically expanded). If the expression is not 
contained in the tree a corresponding message is displayed.  

 

5. Click on Cancel. 
The "MAP120 - Full Text Search" window disappears. 
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8.3 Special functions 

Special functions can be called up in the Extras menu.  

8.3.1 Calling up licensing functions 

The licensing functions can be called up by selecting License in the Extras 
menu. All licensing functions are fully described in section 3 "Licensing".  

8.3.2 Specifying the language 

This function allows you to specify the dialog language for the tool and the 
tree.  
 

 No immediate changes 
Changes to the language settings are only effective following a new start of 
the MAP120 Parameter Editor. 

 

Procedure: 

1. Select Startup Language from the Extras menu.  
The "MAP120 - Language" window appears.  

 

 

2. Select the desired language in the selection box.  
English and German are available.  

3. Click on OK. 
The "MAP120 - Language" window disappears. Close the application 
and restart it to make the language change effective. 
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8.3.3 Specifying general tool settings 

This function allows you to specify different general tool settings such as 
view settings, startup behaviour and path to the directory with communica-
tion settings.  

Procedure: 

1. Select Options from the Extras menu.  
The "MAP120 - General Options" window appears with selected "View" 
tab. 

 

 

2. If you want to display the five digit identifier numbers in the tree, 
activate the check box "Show tree ID's".  

The representation of the parameter tree is described in section 7 
"Parameterisation tree". 

3. If you want to change the startup behaviour, select the desired option 
field:  

- "show communication center" displays the "MAP120 - Communi-
cation Center" window after each startup.  

- "open last device description" displays the last used device defi-
nition automatically after each startup. 

- "blank screen" displays the MAP120 Parameter editor with blank 
user interface after each startup. 

4. If you want to change the path to the directory with communication set-
tings click on the "File Locations" tab. Otherwise continue with point 6.  
The "File Locations" tab is displayed. 

 

 

View 

File Locations 
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5. In the "Communication Settings" entry field enter the path to the 
directory with communication settings or click on Browse and then 
select the desired directory in the tree structure which appears.  
The free choice of the directory allows the sharing of communication 
profiles with different users of a PC. 

 

 Copy communication profiles manually 
Please note that the existing communication profiles aren't moved nor 
copied if the directory has been changed. You must copy the files manually 
into the new directory. 

 
6. Click on OK. 

The "MAP120 - Options" window disappears.  

8.3.4 Calling up comparing functions 

The comparing functions can be called up by selecting Compare to File or 
Compare to Meter in the Extras menu. They are described in sections 
7.3.2 "Comparing parameterisation tree to file" and 7.3.3 "Comparing 
parameterisation tree to device".  

 

8.4 Window arrangement functions 

The following functions can be selected in the Window menu:  

 New Window 
Creates a new window that views the same device definition. 

 Cascade 
Arranges windows in an overlapped fashion. 

 Tile 
Arranges windows in non-overlapped tiles. 

 Arrange Icons 
Arranges icons of closed windows. 

Since these functions are standard Windows functions they will not be 
explained in more detail at this point. Details are found in the Windows 
manual belonging to your personal computer.  
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8.5 Help functions 

Help functions can be called up in the Help menu.  

8.5.1 Displaying help topics 

This function permits access to the help texts for the Landis+Gyr MAP120 
Parameter Editor. These help texts correspond to the contents of this user 
manual.  

Procedure: 

1. Select Help Topics from the Help menu.  
The online help for the Landis+Gyr MAP120 Parameter Editor appears.  

 

2. Find the desired information.  
Since the help function is a standard Windows function it will not be 
explained at this point. More details are found in the Windows manual 
belonging to your personal computer.   

3. Click on  to close the online help.  

8.5.2 Calling up context-sensitive online help 

The context-sensitive online help can be called up with function key [F1]. 
The relevant help topic is displayed directly depending on where the focus 
is set at the time of call-up on the user surface of the Landis+Gyr MAP120 
Parameter Editor. In this case the help text need not be sought yourself via 
the table of contents or the index. 
 
The help texts displayed originate from the contents of the functional de-
scription of the relevant device, if the focus has been set on a tree item of 
the active device definition window. 

 
The help texts displayed originate from the contents of the user manual, if 
the focus has been set on an element of the Landis+Gyr MAP120 Para-
meter Editor, e.g. on a dialogue window of the tool.  

Tree help 

Tool help 
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Example of help topic called up with [F1] if the focus is on the window 
"MAP120 - Full Text Search". 

8.5.3 Displaying read-me file 

This function displays the latest read-me file. 

Procedure: 

1. Select Release Notes from the Help menu.  
The latest read-me file appears. 

 

2. Obtain the information you are interested in. 

3. Click on Close to close the read-me file again. 
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8.5.4 Displaying the current program release and checking for updates 

This function permits the display of information on the current program 
release and checking whether the installed MAP120 release is up to date.  
 

 Internet access required 
To perform a check for updates the PC must have access to the Internet, 
since the MAP Home Page must be contacted for this. 

 

Procedure: 

1. Click on  in the toolbar or select About from the Help menu.  
The "MAP120 - About" window appears. It contains information about 
the current version of the program and about the Windows version 
installed on this computer.  

 

2. Click on Check for Update if you want to check whether the installed 
MAP120 version is up to date.  
An automatic query is performed on the MAP Home Page to determine 
the latest released version available.  

 

The  icon is displayed while the query is performed. 
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The  icon is displayed, if the installed version is up to date.  

If a later release is available, the  icon appears. To download and 
install the latest release of the MAP120 software click on this icon or on 
the MAP icon to access the MAP Software Download area.  

If the  icon is displayed, no information is available or the internet 
access failed. 

3. Click on OK. 
The "MAP120 - About" window disappears.  
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9 Support 
The following is designed to help you take the right measure to tackle any 
problems you may experience when using the Landis+Gyr MAP120 Para-
meter Editor.  

If a problem arises try to solve it yourself first by applying the following 
measures: 

 Consult the appropriate section of this manual 

 Call up the context-sensitive help function as described in section 8.5.2 
"Calling up context-sensitive online help". 

 Call up and read the read-me file as described in section 8.5.3 
"Displaying read-me file" (the file ReadMe.txt was supplied with the 
software).  

If these measures do not help, contact your local Landis+Gyr representa-
tive.  
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10 Short description of device security system 

10.1 Introduction 

The data and parameters of the Landis+Gyr devices are protected against 
unintended or improper access by a flexible, multi-stage security system. It 
is very similar to the one used in computer systems and consists of several 
access levels (users) with different access rights.  

Detailed information on the security system for the relevant devices is pro-
vided in the associated functional descriptions. 

10.2 Security attributes 

For each access level, various security attributes can be defined that must 
be fulfilled to gain access. 
 
Under the main face plate, protected by the verification seal, there is a 
block of security switches or jumpers. Their position must be defined in 
order to gain access to a particular level.  
 
It may be defined that access to a certain level will only be granted from the 
service menu. To enter the service menu the utility seal must be removed.  
 
A password may be defined for some access levels. Either a static 8-char-
acter password, a coded 7-character password or a 32-character encryp-
tion key can be used.  

If a static password is used, the user only needs to know the password. It is 
checked by the device and access is granted, if the passwords match.  

If a coded password or an encryption key is used, the user not only needs 
to know the password but also an encryption algorithm. Due to the encryp-
tion a Landis+Gyr tool is required to access such a level. 

Only the characters '0' to '9' and 'A' to 'F' are allowed for passwords and 
keys. 
 
The access to a certain level may be restricted so that it is only granted via 
selected communication channels. Access is for instance possible via the 
optical interface, the integrated interface and both communication channels 
of the communication unit.  

10.3 Access levels 

The Landis+Gyr devices feature up to 15 different access levels (level 0 to 
9 and A to E) with different access rights each. For groups of registers and 
parameters, it can be defined which level is required to read and which 
level is required to write.  

Each access level is protected by security attributes which must be fulfilled 
to gain access. In order to simplify the handling and to ensure compatibility 
to other device series, most of the security attributes have been partially or 
completely fixed. 

All access levels are strictly independent i.e. a higher access level does not 
automatically bear all rights of the lower access levels.  

Switches protected by 
the verification seal 

Entering the service 
menu 

Passwords/Keys 

Communication 
channels 
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10.4 Access levels and their application 

The table below describes all access levels with their security attributes and 
their typical application. The access rights are defined by the utility when 
ordering the device. They depend on the needs of the utility and on the 
national regulations.  

For levels 0 to 4 access is possible via the dlms and the IEC protocol, for 
levels 5 to E via the dlms protocol only. The UID (user identification) is used 
in dlms communication to select the access level. 

Please note that not all access levels are available in all devices, the table 
below therefore just gives an overview. Please always refer to the func-
tional description of the currently used device.  
 

Level Security attributes Access rights and typical application examples 

0 

Public Access 

UID = 16 

without password 

without breaking a seal 

all interfaces 

This access level is always available. All dlms devices 
can be accessed on this level. 

All data can be read but there is no write access.  

1 

Data Collection 

UID = 32 

with static password 

without breaking a seal 

interfaces selectable 

Readout of billing data by means of a handheld termi-
nal or possibly by a central system. 

All billing data is readable. 

Limited write access possible, e.g. time/date.  

2 

Utility Field Service 

UID = 48 

with coded password or 
encryption key 

without breaking a seal 

interfaces selectable 

Landis+Gyr Tool required 
because of coded pass-
word or encryption algo-
rithm 

Installation or maintenance tasks in the field. 

All parameters and all billing data are readable. 

Limited write access to uncritical data is possible, e.g. 
device addresses, identification numbers, phone num-
bers etc. 

3 

Utility Service 

UID = 64 

without password 

breaking the utility seal 
necessary 

local interfaces only 

Installation or maintenance work in the utility after 
verification. 

All parameters and all billing data are readable. 

Limited write access to settable data is possible, e.g. 
battery operating time, switching tables etc. 

4 

Extended Utility Service 

UID = 80 

without password 

breaking the verification 
seal necessary 

local interfaces only 

Installation or maintenance work in the utility before 
verification. 

All parameters and all billing data are readable. 

Write access to all data is possible, e.g. parameter-
isation, register clearing, password setting etc. 

5  

Extended Consumer 

UID = 17 

with static password 

without breaking a seal 

interfaces selectable 

Write access for the end user. 

All parameters and most billing data are readable. 

Limited write access to the end user data is possible, 
e.g. monitor thresholds. 

6 

Remote Data Collection 

UID = 18 

with static password 

without breaking a seal 

remote interfaces only 

Remote readout of billing data by a central system. 

All billing data are readable. 

Limited write access is possible, e.g. time/date. 

7 

Remote Service 

UID = 19 

with static password 

without breaking a seal 

remote interfaces only 

Installation or maintenance work in connection with a 
central system. 

All parameters and all billing data are readable. 

Limited write access to settable data is possible, e.g. 
switching tables, device addresses, identification 
numbers, phone numbers etc. 
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Level Security attributes Access rights and typical application examples 

8, 9  Reserved for future expansion. 

A 

Utility Defined 

UID = 22 

attributes selectable at 
ordering time 

No typical application defined.  

Access rights defined at ordering time according to the 
needs of the utility. 

B  Reserved for future expansion. 

C 

Read Administrator 

UID = 96 

with static password 

without breaking a seal 

Allocation of read access rights 

All parameter and all billing data are readable. 

Read access rights for all lower levels (0 to B) can be 
allocated. 

D 

Utility Administrator 

UID = 97 

with coded password 

breaking the verification 
seal necessary 

local interfaces only 

Landis+Gyr Tool required 
because of coded pass-
word 

Same as level 4. 

In addition, changes in the utility security system are 
possible: 

Read and write access rights can be adapted and all 
passwords can be changed. 

E 

Distributor Service 

UID = 100 

with coded password 

breaking the verification 
seal necessary 

local interfaces only 

Landis+Gyr Tool required 
because of coded pass-
word 

Service access of the distributor.  
Identical to level D. 

In addition, changing the access rights and the pass-
word of the utility administrator is possible. 
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11 OBIS identification codes 

11.1 General description 

For OBIS (Object Identification System) the structure A-B:C.D.E.F applies, 
whereby the individual groups have the following significance: 
 
A  Defines the characteristic of the data item to be identified, e.g. ab-

stract data, electricity-, gas-, heat- or water-related data. 

B  Defines the channel number, i.e. the number of the input of a meter-
ing equipment having several inputs for the measurement of energy 
of the same or different types (e.g. in data concentrators, registration 
units). This enables data from different sources to be identified. 

C  Defines the abstract or physical data items related to the information 
source concerned, e.g. active power, reactive power, apparent 
power, power factor, current or voltage. 

D  Defines types, or the result of the processing of physical quantities 
according to various specific algorithms. The algorithms can deliver 
energy and demand quantities as well as other physical quantities. 

E  Defines the further processing of measurement results to tariff reg-
isters, according to the tariffs in use. For abstract data or for meas-
urement results for which tariffs are not relevant, this value group can 
be used for further classification. 

F  Defines the storage of data according to different billing periods. 
Where this is not relevant, this value group can be used for further 
classification. 

 
To simplify the reading in the index field, individual groups of the OBIS 
code can be omitted. The abstract or physical data C and type of data D 
must be shown. A full specification of the OBIS identification number 
system can be found in standard IEC 62056-61. 

Only the values of interest to metering devices are explained below with a 
collection of examples. 
 
Group A of the OBIS identification can theoretically have values in the 
range between 0 and 15. Only the values 
0 (abstract objects) and   
1 (electricity related objects)   
appear in the Landis+Gyr MAP120 Parameter Editor. 
 
Group B of the OBIS identification can theoretically have values in the 
range between 0 and 255. Only the values  
0 (no channel specified)   
1 (channel 1) and   
2 (channel 2)   
appear in the Landis+Gyr MAP120 Parameter Editor. 
 
Group C of the OBIS identification can have values in the range between 0 
and 255. The individual values are differently assigned depending on the 
value of group A. The values for abstract items (group A = 0) are of no in-
terest at this point, since they are largely specific to either context, country 
or manufacturer. On the other hand, the values for items related to electric-
ity are listed in the following table. 
 

Value Application 

Group A 

Group B 

Group C 
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Value Application 

0 General purpose objects 

1 Sum of all phases: active energy import (+A) 

2 Sum of all phases: active energy export (-A) 

3 Sum of all phases: reactive energy import (+R) 

4 Sum of all phases: reactive energy export (-R) 

5 Sum of all phases: reactive energy quadrant I (+Ri) 

6 Sum of all phases: reactive energy quadrant II (-Rc) 

7 Sum of all phases: reactive energy quadrant III (-Ri) 

8 Sum of all phases: reactive energy quadrant IV (+Rc) 

9 Sum of all phases: apparent energy import (+S) 

10 Sum of all phases: apparent energy export (-S) 

11 Any phase: current  

12 Any phase: voltage  

13 Average power factor (cos) 

14 Mains frequency (fn) 

15 Sum of all phases: active energy quadrant I+IV+II+III 

16 Sum of all phases: active energy quadrant I+IV-II-III 

17 Sum of all phases: active energy quadrant I 

18 Sum of all phases: active energy quadrant II 

19 Sum of all phases: active energy quadrant III 

20 Sum of all phases: active energy quadrant IV 

21 Phase 1: active energy import 

22 Phase 1: active energy export 

23 Phase 1: reactive energy import 

24 Phase 1: reactive energy export 

25 Phase 1: reactive energy quadrant I 

26 Phase 1: reactive energy quadrant II 

27 Phase 1: reactive energy quadrant III 

28 Phase 1: reactive energy quadrant IV 

29 Phase 1: apparent energy import 

30 Phase 1: apparent energy export 

31 Phase 1: current 

32 Phase 1: voltage 

33 Phase 1: power factor 

34 Phase 1: frequency 

35 Phase 1: active energy quadrant I+IV+II+III 

36 Phase 1: active energy quadrant I+IV-II-III 

37 Phase 1: quadrant I 

38 Phase 1: quadrant II 

39 Phase 1: quadrant III 
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Value Application 

40 Phase 1: quadrant IV 

41…60 Phase 2: same as 21…40 

61…80 Phase 3: same as 21…40 

81 Phase angles 

82 Unitless quantity (pulses or pieces) 

83...90 Not used 

91 Neutral: current 

92 Neutral: voltage 

93...95 Not used 

96 Electricity-related service entries 

97 Electricity-related error messages 

98 Electricity-related list objects 

99 Data profiles 

100...127 Reserved 

128...254 Manufacturer-specific definitions 

Landis+Gyr: 

130 = Sum of all phases: reactive energy quadrant I+IV+II+III 
131 = Sum of all phases: reactive energy quadrant I+II-III-IV 
132 = Sum of all phases: reactive energy quadrant I+IV 
133 = Sum of all phases: reactive energy quadrant II+III 

150 = Phase 1: reactive energy quadrant I+IV+II+III 
151 = Phase 1: reactive energy quadrant I+II-III-IV 
152 = Phase 1: reactive energy quadrant I+IV 
153 = Phase 1: reactive energy quadrant II+III 

170 = Phase 2: reactive energy quadrant I+IV+II+III 
171 = Phase 2: reactive energy quadrant I+II-III-IV 
172 = Phase 2: reactive energy quadrant I+IV 
173 = Phase 2: reactive energy quadrant II+III 

190 = Phase 3: reactive energy quadrant I+IV+II+III 
191 = Phase 3: reactive energy quadrant I+II-III-IV 
192 = Phase 3: reactive energy quadrant I+IV 
193 = Phase 3: reactive energy quadrant II+III 

255 Reserved 

 
Group D of the OBIS identification can have values in the range between 0 
and 255. The individual values are differently assigned depending on the 
value of group A and C, but are not described here. 
 
Group E of the OBIS identification can have values in the range between 0 
and 255. In the Landis+Gyr MAP120 Parameter Editor for group E for elec-
tricity-related items (group A = 1) the values corresponding to the number 
of tariffs specified mainly appear (0 = total of all tariffs, 1 = tariff 1, 2 = tariff 
2 etc.). Other values apply for specific values of group C, but these are not 
described here.  
 
Group F of the OBIS identification can have values in the range between 0 
and 255. In the Landis+Gyr MAP120 Parameter Editor group F is not used 
and is therefore always set to 255.  

Group D 

Group E 

Group F 
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11.2 Examples 

The following table shows a selection of OBIS identification numbers and 
explains their significance. 
 

OBIS code 
(decimal) 

OBIS code (hex) Description 

 A   B   C   D   E   F 

0-0:1.0.0 00  00  01  00  00  FF Clock 

0-0:42.0.0 00  00  2A  00  00  FF dlms device identification 

0-0:C.1.0 00  00  60  01  00  FF Identification number 2.1 

0-0:C.1.1 00  00  60  01  01  FF Identification number 2.2 

0-0:C.2.0 00  00  60  02  00  FF Number of parameterisations 

0-0:C.2.1 00  00  60  02  01  FF Date and time of last 
parameterisation 

0-0:C.2.2 00  00  60  02  02  FF Activation date TOU 

0-0:C.2.3 00  00  60  02  03  FF Date of last RCR program change 

0-0:C.240.0 00  00  60  F0  00  FF EEPROM identification 

0-0:C.240.13 00  00  60  F0  0D  FF Hardware ID 

0-0:C.3.1 00  00  60  03  01  FF Input terminal states base meter 

0-0:C.3.2 00  00  60  03  02  FF Output terminal states base meter 

0-0:C.4.0 00  00  60  04  00  FF Internal control signal states 

0-0:C.5.0 00  00  60  05  00  FF Internal operating state 

0-0:C.6.0 00  00  60  06  00  FF Operating time of battery 

0-0:C.6.3 00  00  60  06  03  FF Battery voltage 

0-0:C.7.0 00  00  60  07  00  FF Number of phase fails L1..L3 

0-0:C.7.1 00  00  60  07  01  FF Number of phase fails L1 

0-0:C.7.2 00  00  60  07  02  FF Number of phase fails L2 

0-0:C.7.3 00  00  60  07  03  FF Number of phase fails L3 

0-0:C.8.0 00  00  60  08  00  FF Total operating time 

0-0:C.8.t 00  00  60  08  t    FF Operating time (t = tariff number) 

0-0:C.90 00  00  60  5A  FF  FF Configuration ID 

0-0:C.90.1 00  00  60  5A  01  FF Physical IEC device address 

0-0:C.90.2 00  00  60  5A  02  FF Physical HDLC device address 

1-0:C.2.7 00  00  60  02  07  FF Activation date passive TOU 

0-0:F.F.0 00  00  61  61  00  FF Error code register 

0-0:L.1.0*126 00  00  62  01  00  7E Stored values 

0-0:240.1.0 00  00  F0  01  00  FF Device functions 

0-1:C.2.5 00  01  60  02  05  FF Date and time of last calibration 

0-1:C.240.8 00  01  60  F0  08  FF Hardware ID of base meter 

0-1:C.3.1 00  01  60  03  01  FF Input terminal states extension board 

0-1:C.3.2 00  01  60  03  02  FF Output terminal states extension 
board 
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OBIS code 
(decimal) 

OBIS code (hex) Description 

 A   B   C   D   E   F 

0-2:C.240.8 00  02  60  F0  08  FF Hardware ID of extension board 

0-2:C.240.9 00  02  60  F0  09  FF Reference hardware ID of extension 
board 

1-0:0.0.1 01  00  00  00  00  FF Identification number 1.1 

1-0:0.0.2 01  00  00  00  01  FF Identification number 1.2 

1-0:0.0.3 01  00  00  00  02  FF Identification number 1.3 

1-0:0.0.4 01  00  00  00  03  FF Identification number 1.4 

1-0:0.1.0 01  00  00  01  00  FF Reset counter 

1-0:0.1.2 01  00  00  01  02  FF Time and date of last billing period 
reset 

1-0:0.2.0 01  00  00  02  00  FF Software ID 

1-0:0.2.1 01  00  00  02  01  FF Parameterisation ID 

1-0:0.2.3 01  00  00  02  03  FF Ripple control receiver ID 

1-0:0.2.4 01  00  00  02  04  FF Connection ID 

1-0:0.2.7 01  00  00  02  07  FF Passive TOU ID 

1-0:0.9.5 01  00  00  09  05  FF Weekday 

1-0:C.99.8 01  00  60  69  08  FF Display and IEC readout ID 

1-0:P.1.0 01  00  63  01  00  FF Load profile 

1-0:P.98.0 01  00  63  62  00  FF Event log 

1-1:0.3.0 01  01  00  03  00  FF Meter constant active energy 

1-1:0.3.1 01  01  00  03  01  FF Meter constant reactive energy 

1-1:0.4.0 01  01  00  04  00  FF Scale factor for demand display 

1-1:0.4.1 01  01  00  04  01  FF Scale factor for energy display 

1-1:0.4.2 01  01  00  04  02  FF Current transformer ratio 

1-1:0.4.3 01  01  00  04  03  FF Voltage transformer ratio 

1-1:13.0.0 01  01  0D  00  00  FF Average billing period power factor 

1-1:13.3.n 01  01  0D  03  n   FF Power factor minimum (n = number) 

1-1:13.31.n 01  01  0D  23  n   FF Power factor threshold (n = number) 

1-1:13.35.n 01  01  0D  23  n   FF Power factor monitor threshold 
(n = number) 

1-1:13.5.0 01  01  0D  00  00  FF Last average power factor 

1-1:13.7.0 01  01  0D  07  00  FF Total power factor 

1-1:14.7.0 01  01  0E  07  00  FF Mains frequency 

1-1:16.7.0 01  01  10  07  00  FF Active energy  

1-1:31.7.0 01  01  1F  07  00  FF Current L1 

1-1:31.35.0 01  01  1F  23  00  FF Overcurrent threshold L1 

1-1:32.7.0 01  01  20  07  00  FF Voltage L1 

1-1:32.31.0 01  01  20  1F  00  FF Undervoltage threshold L1 

1-1:32.35.0 01  01  20  23  00  FF Overvoltage threshold L1 
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OBIS code 
(decimal) 

OBIS code (hex) Description 

 A   B   C   D   E   F 

1-1:33.7.0 01  01  21  07  00  FF Power factor L1 

1-1:51.7.0 01  01  33  07  00  FF Current L2 

1-1:51.35.0 01  01  33  23  00  FF Overcurrent threshold L2 

1-1:52.7.0 01  01  34  07  00  FF Voltage L2 

1-1:52.31.0 01  01  34  1F  00  FF Undervoltage threshold L2 

1-1:52.35.0 01  01  34  23  00  FF Overvoltage threshold L2 

1-1:53.7.0 01  01  35  07  00  FF Power Factor L2 

1-1:71.7.0 01  01  47  07  00  FF Current L3 

1-1:71.35.0 01  01  47  23  00  FF Overcurrent threshold L3 

1-1:72.7.0 01  01  48  07  00  FF Voltage L3 

1-1:72.31.0 01  01  48  1F  00  FF Undervoltage threshold L3 

1-1:72.35.0 01  01  48  23  00  FF Overvoltage threshold L3 

1-1:73.7.0 01  01  49  07  00  FF Power Factor L3 

1-1:81.7.0 01  01  51  07  00  FF Angle U(L1) to U(L1) 

1-1:81.7.1 01  01  51  07  01  FF Angle U(L2) to U(L1) 

1-1:81.7.2 01  01  51  07  02  FF Angle U(L3) to U(L1) 

1-1:81.7.3 01  01  51  07  04  FF Angle I(L1) to U(L1) 

1-1:81.7.4 01  01  51  07  05  FF Angle I(L2) to U(L1) 

1-1:81.7.5 01  01  51  07  06  FF Angle I(L3) to U(L1) 

1-1:91.7.0 01  01  5B  07  00  FF Neutral current 

1-1:91.35.0 01  01  5B  23  00  FF Overcurrent threshold N 

1-1:131.7.0 01  01  83  07  00  FF Reactive energy 

1-1:m.2.0 01  01  m   02  00  FF Cumulative maximum demand 
(m = measured quantity) 

1-1:m.4.0 01  01  m   04  00  FF Current average demand 
(m = measured quantity) 

1-1:m.6.t 01  01  m   06  t    FF Maximum demand register 
(m = measured quantity, t = tariff 
number) 

1-1:m.8.0 01  01  m   08  00  FF Total energy register (m = measured 
quantity) 

1-1:m.8.t 01  01  m   08  t    FF Energy register (cumulative) 
(m = measured quantity, t = tariff 
number) 

1-1:m.9.t 01  01  m   09  t    FF Energy register (billing period delta 
value) (m = measured quantity, t = 
tariff number) 

1-1:m.29.t 01  01  m   1D  t    FF Energy register (registration period 
delta value) (m = measured quantity, 
t = tariff number) 

1-1:m.35.n 01  01  m   23  n   FF Demand register monitor threshold 
(m = measured quantity, n = number) 

1-2:82.8.0 01  02  52  08  00  FF Counter S0 pulses input 1 
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OBIS code 
(decimal) 

OBIS code (hex) Description 

 A   B   C   D   E   F 

1-3:82.8.0 01  03  52  08  00  FF Counter S0 pulses input 2 

a-2:m.8.0 a    02  m   08  00  FF External pulse input 1 (a = medium, 
m = measured quantity) 

a-3:m.8.0 a    03  m   08  00  FF External pulse input 2 (a = medium, 
m = measured quantity) 
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12 List of abbreviations 
This section explains abbreviations used in this user manual or on dialog 
windows of the Landis+Gyr MAP120 application in alphabetical order.  
 
Definition 
Description 
 
Companion Specification for Energy Metering  
Comprises the specifications required in addition to dlms (as defined in 
IEC 61334-4-41, 1996), which describe the interface to the device. 
These are namely the standards (drafts) IEC 62056-42, IEC 62056-46, 
IEC 62056-53, IEC 62056-61 and IEC 62056-62. 
 
Distribution Line Message Specification  
Messaging system defined originally as part of the application layer of the 
protocol stack for distribution line carrier systems (IEC 61334-4-41, 1996). 
Its universality and its independence of the actual communication channel 
allowed dlms to become the choice of the metering industry for any meter-
ing application (Device Language Message Specification). 
 
Global System for Mobile communications  
Wireless communication network for data and voice transmission.  
 
High Level Data Link Control  
Communication protocol used by COSEM (IEC 62056-46), specifying the 
data link layer. The HDLC standard is ISO/IEC 13239, 2000 (second edi-
tion). Some older COSEM implementations rely on the first, 1996 edition of 
the standard.  
 
International Electrotechnical Commission  
IEC 62056-21 is the standard "Electricity metering - Data exchange for meter 
reading, tariff and load control - Part 21: Direct local data exchange". This is 
the third edition of the formerly well-known standard IEC 61107 (IEC 1107). 
 
Meter Application Product  
The MAP software tools have been developed and distributed by 
Landis+Gyr to support electricity meters. This group of tools comprises the 
MAP 190 Parameterisation Editor Tool and the MAP120 Parameter Editor.  
 
Object Identification System  
Identification number system for clear identification of dlms items. 
 
Public Switched Telephone Network   
The public switched telephone network can be used for data transmission. 
To this purpose a modem (modulator/demodulator) must be inserted be-
tween computer and telephone network and also between the telephone 
network and the remote device.  
 
Vereinigung Deutscher Elektrizitätswerke  
VDEW is the central organisation of the German electrical industry. It com-
bines and represents the interests of its members and is consultant and 
forward-looking body for energy questions (refer also to www.strom.de). 

 

Abbreviation 

COSEM 

dlms 

GSM 

HDLC 

IEC 

MAP 

OBIS 

PSTN 

VDEW 
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13 Index 
Access levels ......................................... 28, 82 
Actions to be performed before or after 

parameterisation ...................................... 40 
Addressing devices ...................................... 30 
Application of access levels ......................... 83 
Application of MAP120 functions .................. 58 
Calling up context-sensitive online help ....... 77 
Certification feature ...................................... 52 
Change 

all parameters except security system 42, 49 
modem initialisation strings ..................... 51 
passwords ............................................... 29 
security system.................................. 47, 50 
TOU ........................................................ 46 

Check for Update ......................................... 79 
Closing device definition windows ................ 61 
Collapsing tree folders ................................. 71 
COM port settings ........................................ 27 
Communication center ................................. 22 
Communication channels ............................... 6 
Communication examples ............................ 31 
Communication profile ............................. 8, 23 
Communication protocols ............................... 7 
Communication unit ..................................... 38 
Communication with devices ........................ 22 
Comparing parameterisation tree 

to device .................................................. 54 
to file ....................................................... 53 

Conditions for the use of this user manual ..... 5 
Conventions ................................................... 5 
COSEM ....................................................... 92 
Creating new device definitions .................... 58 
Current version of the program .................... 79 
Defining the print layout ............................... 65 
Device address ............................................ 30 
Device definition 

generation ............................................... 58 
window .................................................... 18 

Device security system ................................ 82 
Direct connection ......................................... 25 
Displaying help topics .................................. 77 
dlms ............................................................. 92 
Document Types .......................................... 23 
Echo handling settings ................................. 27 
Editions .......................................................... 7 
Entering 

license data ............................................. 10 
passwords ............................................... 14 

Examples of OBIS identification codes ......... 88 
Expanding tree folders ................................. 71 
Exporting TOU table .................................... 55 
Fields of application of the MAP120 ............... 6 
File handing functions .................................. 58 
File types ..................................................... 60 
First steps .................................................... 12 
Folder handling ............................................ 19 

Full text search ............................................. 73 
Functions ........................................................ 6 
Further documents ....................................... 38 
General tool settings ..................................... 75 
HDLC ........................................................... 92 

transmit buffer size ................................... 27 
Help functions ............................................... 77 
IEC ............................................................... 92 
Ignore transmission rate switching ................ 27 
Importing MAP190 files ................................. 39 
Improper data access ................................... 82 
Installation of the MAP120 .............................. 8 
Interface to device ........................................ 25 
Language ....................................................... 8 
Language selection ...................................... 74 
Licence data ................................................. 10 
License key entry .......................................... 10 
Licensing concept ......................................... 10 
List of abbreviations ...................................... 92 
Local connection ........................................... 31 
MAP ............................................................. 92 
MAP120 Communication Center .................. 22 
Maximum transmission rate .......................... 27 
Menu bar ...................................................... 17 
Modem connection ................................. 25, 33 
Multiple connection ....................................... 31 
Network connection ...................................... 25 

via LAN .................................................... 36 
Network delays ............................................. 27 
OBIS ............................................................. 92 

identification codes................................... 85 
Object identification system OBIS ................. 85 
Opening existing device definitions ............... 60 
Page setup ................................................... 65 
Parameter overwriting protection .................. 82 
Parameterisation tree ................................... 39 
Parameterisation wizard ............................... 40 
Password protection ..................................... 82 
Passwords .............................................. 14, 29 
Physical device address ............................... 30 
Previewing the printout on the screen ........... 67 
Print 

layout definition ........................................ 65 
preview .................................................... 67 
setup ........................................................ 69 

Printing device definitions ............................. 63 
Problem solving ............................................ 81 
Program termination ..................................... 70 
Program version ........................................... 79 
PSTN ............................................................ 92 
Purpose of this user manual ........................... 5 
Reading head ............................................... 25 
Read-me file ................................................. 78 
Release notes............................................... 78 
Saving device definitions .............................. 61 

under a new name ................................... 62 



94/96      Index 

© Landis+Gyr D000011154 en t – MAP120 – Parameter Editor – User Manual 

Screen areas ................................................ 16 
Searching items ............................................ 73 
Security attributes ......................................... 82 
Security switches .......................................... 82 
Security system ............................................ 82 
Selecting access level .................................. 28 
Selecting data in parameterisation tree......... 39 
Setting up 

a communication profile ........................... 13 
the printer ................................................ 69 

Special functions .......................................... 74 
Special text marks for printout ...................... 66 
Specifying general tool settings .................... 75 
Start protocol settings ................................... 26 
Starting the parameterisation wizard ............ 40 
Startup behaviour ......................................... 75 
Status bar ............................................... 21, 72 
Support......................................................... 81 
System requirements ...................................... 8 
Target group of this user manual .................... 5 

Terminating the program .............................. 70 
Tool help ...................................................... 77 
Tool settings ................................................. 75 
Toolbar ................................................... 17, 71 
Trace window ............................................... 20 
Transmission rate ......................................... 27 
Tree help ...................................................... 77 
Tree items .................................................... 19 
Tree representation ...................................... 19 
Types of files ................................................ 60 
UnInstallation ................................................. 9 
Update check ............................................... 79 
Update firmware version .............................. 57 
Upgrades ....................................................... 8 
User interface ............................................... 16 
VDEW .......................................................... 92 
Versions of the MAP120 ................................. 7 
View functions .............................................. 71 
View settings ................................................ 75 
Window arrangement functions .................... 76 

 

 

 
 
 



Index     95/96 

D000011154 en t – MAP120 – Parameter Editor – User Manual © Landis+Gyr 

 
 



 

 

 

 

Contact: 

Landis+Gyr AG 

Theilerstrasse 1 

CH-6301 Zug 

Switzerland 

Phone: +41 41 935 6000 

www.landisgyr.com 


	1 Overview
	1.1 Functions
	1.2 Communication channels
	1.3  Communication protocols
	1.4 Editions

	2 Installation and uninstallation
	2.1 Installation
	2.2 Uninstallation

	3 Licensing
	3.1 Introduction to the licensing concept
	3.2 Entering license data

	4 First steps
	5 Description of user interface
	5.1 Overview
	5.2  Menu bar
	5.3 Tool bar
	5.4  Device definition window
	5.5 Trace window
	5.6  Status bar

	6 Communication with devices
	6.1 MAP120 communication center
	6.1.1  Document types
	6.1.2 Communication profiles
	6.1.3  Interface to device
	6.1.4  Access levels
	6.1.5  Passwords
	6.1.6  Addressing devices

	6.2  Communication examples
	6.2.1 Local connection
	6.2.2 Modem connection
	6.2.3 Network connection via a LAN

	6.3 Reference to other documents

	7 Parameterisation tree
	7.1 Overview
	7.2 Parameterisation wizard
	7.2.1 Starting the parameterisation wizard
	7.2.2 Change all device parameters except security system
	7.2.3  Change TOU
	7.2.4 Change device security system
	7.2.5 Change all CU parameters except security system
	7.2.6 Change CU security system
	7.2.7 Change CU modem initialisation strings

	7.3 Parameterisation tree functions
	7.3.1 Switching the certification feature on or off
	7.3.2 Comparing parameterisation tree to file
	7.3.3 Comparing parameterisation tree to device
	7.3.4 Exporting TOU table
	7.3.5 Update firmware version


	8 Application of MAP120 functions
	8.1 File handling functions
	8.1.1 Creating new device definitions
	8.1.2  Opening existing device definitions
	8.1.3 Closing device definition windows
	8.1.4 Saving device definitions
	8.1.5  Saving device definitions under a new name
	8.1.6 Printing device definitions
	8.1.7  Defining the print layout
	8.1.8 Previewing the printout on the screen
	8.1.9 Setting up the printer
	8.1.10  Terminating the program

	8.2  View functions
	8.2.1 Expanding and collapsing tree folders
	8.2.2 Switching the toolbar on and off
	8.2.3  Switching the status bar on and off
	8.2.4 Searching items

	8.3  Special functions
	8.3.1 Calling up licensing functions
	8.3.2 Specifying the language
	8.3.3  Specifying general tool settings
	8.3.4 Calling up comparing functions

	8.4 Window arrangement functions
	8.5  Help functions
	8.5.1 Displaying help topics
	8.5.2 Calling up context-sensitive online help
	8.5.3 Displaying read-me file
	8.5.4  Displaying the current program release and checking for updates


	9 Support
	10 Short description of device security system
	10.1 Introduction
	10.2 Security attributes
	10.3 Access levels
	10.4  Access levels and their application

	11 OBIS identification codes
	11.1 General description
	11.2 Examples

	12 List of abbreviations
	13 Index

